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Warranty
Tektronix warrants that this product will be free from defects in materials and workmanship for a period of three (3) years from the date
of shipment. If any such product proves defective during this warranty period, Tektronix, at its option, either will repair the defective
product without charge for parts and labor, or will provide a replacement in exchange for the defective product. Parts, modules and
replacement products used by Tektronix for warranty work may be new or reconditioned to like new performance. All replaced
parts, modules and products become the property of Tektronix.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration of the warranty period
and make suitable arrangements for the performance of service. Customer shall be responsible for packaging and shipping the
defective product to the service center designated by Tektronix, with shipping charges prepaid. Tektronix shall pay for the return of the
product to Customer if the shipment is to a location within the country in which the Tektronix service center is located. Customer shall
be responsible for paying all shipping charges, duties, taxes, and any other charges for products returned to any other locations.

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or inadequate maintenance and
care. Tektronix shall not be obligated to furnish service under this warranty a) to repair damage resulting from attempts by personnel
other than Tektronix representatives to install, repair or service the product; b) to repair damage resulting from improper use or
connection to incompatible equipment; c) to repair any damage or malfunction caused by the use of non-Tektronix supplies; or
d) to service a product that has been modified or integrated with other products when the effect of such modification or integration
increases the time or difficulty of servicing the product.

THIS WARRANTY IS GIVEN BY TEKTRONIX WITH RESPECT TO THE PRODUCT IN LIEU OF ANY OTHER WARRANTIES,
EXPRESS OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE. TEKTRONIX' RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS
IS THE SOLE AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THIS WARRANTY. TEKTRONIX
AND ITS VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES
IRRESPECTIVE OF WHETHER TEKTRONIX OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH
DAMAGES.
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General Safety Summary

General Safety Summary
Review the following safety precautions to avoid injury and prevent damage to this product or any products connected to it.

To avoid potential hazards, use this product only as specified.

Only qualified personnel should perform service procedures.

While using this product, you may need to access other parts of a larger system. Read the safety sections of the other
component manuals for warnings and cautions related to operating the system.

To Avoid Fire or Personal Injury
Use proper power cord. Use only the power cord specified for this product and certified for the country of use.

Connect and disconnect properly. Do not connect or disconnect probes or test leads while they are connected
to a voltage source.

Ground the product. This product is grounded through the grounding conductor of the power cord. To avoid electric
shock, the grounding conductor must be connected to earth ground. Before making connections to the input or output
terminals of the product, ensure that the product is properly grounded.

Observe all terminal ratings. To avoid fire or shock hazard, observe all ratings and markings on the product. Consult the
product manual for further ratings information before making connections to the product.

The inputs are not rated for connection to mains or Category II, III, or IV circuits.

Do not apply a potential to any terminal, including the common terminal, that exceeds the maximum rating of that terminal.

Power disconnect. The power switch disconnects the product from the power source. See instructions for the location.
Do not block the power switch; it must remain accessible to the user at all times.

Do not operate without covers. Do not operate this product with covers or panels removed.

Do not operate with suspected failures. If you suspect that there is damage to this product, have it inspected by
qualified service personnel.

Avoid exposed circuitry. Do not touch exposed connections and components when power is present.

Use proper fuse. Use only the fuse type and rating specified for this product.

Wear eye protection. Wear eye protection if exposure to high-intensity rays or laser radiation exists.

Do not operate in wet/damp conditions.

Do not operate in an explosive atmosphere.

Keep product surfaces clean and dry.
Provide proper ventilation. Refer to the manual's installation instructions for details on installing the product so it has
proper ventilation.
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Terms in This Manual
These terms may appear in this manual:

WARNING. Warning statements identify conditions or practices that could result in injury or loss of life.

CAUTION. Caution statements identify conditions or practices that could result in damage to this product or other property.

Symbols and Terms on the Product
These terms may appear on the product:

DANGER indicates an injury hazard immediately accessible as you read the marking.

WARNING indicates an injury hazard not immediately accessible as you read the marking.

CAUTION indicates a hazard to property including the product.

The following symbol(s) may appear on the product:
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Compliance Information

Compliance Information
This section lists the EMC (electromagnetic compliance), safety, and environmental standards with which the instrument
complies.

EMC Compliance
EC Declaration of Conformity – EMC
Meets intent of Directive 2004/108/EC for Electromagnetic Compatibility. Compliance was demonstrated to the following
specifications as listed in the Official Journal of the European Communities:

EN 61326-1:2006, EN 61326-2-1:2006. EMC requirements for electrical equipment for measurement, control, and
laboratory use. 1 2 3 6

CISPR 11:2003. Radiated and conducted emissions, Group 1, Class A

IEC 61000-4-2:2001. Electrostatic discharge immunity

IEC 61000-4-3:2002. RF electromagnetic field immunity 4

IEC 61000-4-4:2004. Electrical fast transient / burst immunity

IEC 61000-4-5:2001. Power line surge immunity

IEC 61000-4-6:2003. Conducted RF immunity

IEC 61000-4-11:2004. Voltage dips and interruptions immunity 5

EN 61000-3-2:2006. AC power line harmonic emissions

EN 61000-3-3:1995. Voltage changes, fluctuations, and flicker

European contact.
Tektronix UK, Ltd.
Western Peninsula
Western Road
Bracknell, RG12 1RF
United Kingdom

1 This product is intended for use in nonresidential areas only. Use in residential areas may cause electromagnetic interference.

2 Emissions which exceed the levels required by this standard may occur when this equipment is connected to a test object.

3 To ensure compliance with the EMC standards listed here, use high quality shielded interface cables.

4 Horizontal timing susceptibility of the optical sampling modules and their internal clock recovery trigger signals usually increases
the horizontal timing jitter when external electromagnetic fields are applied. For fields up to 3 V/m, the increase in the horizontal
high-frequency RMS jitter is typically less than 3 ps RMS of jitter, added using the square-root-of-the-sum-of-the-squares method.
For example, if an 80C01–CR operating in clock-recovery trigger mode exhibits 3.5 ps RMS of edge jitter, with no EMC field
applied and for an ideal jitterless input, then for applied fields up to 3 V/m the edge jitter, degradation would typically result in
a total RMS jitter of:
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5 Performance Criterion C applied at the 70%/25 cycle Voltage-Dip and the 0%/250 cycle Voltage-Interruption test levels (IEC
61000-4-11). If the instrument powers down upon a voltage dip or interruption, it will take longer than ten seconds to reboot.

6 With an 80E01 Electrical Sampling module, up to 15 mVRMS random noise is allowed when the instrument is subjected to fields and
signals as defined in the IEC 61000-4-3 and IEC 61000-4-6 tests.

Australia / New Zealand Declaration of Conformity – EMC
Complies with the EMC provision of the Radiocommunications Act per the following standard, in accordance with ACMA:

CISPR 11:2003. Radiated and Conducted Emissions, Group 1, Class A, in accordance with EN 61326-1:2006 and
EN 61326-2-1:2006.
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Safety Compliance
EC Declaration of Conformity – Low Voltage
Compliance was demonstrated to the following specification as listed in the Official Journal of the European Communities:

Low Voltage Directive 2006/95/EC.

EN 61010-1: 2001. Safety requirements for electrical equipment for measurement control and laboratory use.

U.S. Nationally Recognized Testing Laboratory Listing
UL61010-1, 2nd Edition. Safety requirements for electrical equipment for measurement, control, and laboratory use-
Part 1.

Canadian Certification
CAN/CSA-C22.2 No. 61010-1-2004. Safety requirements for electrical equipment for measurement, control, and
laboratory use- Part 1

Additional Compliances
IEC 61010-1: 2001. Safety requirements for electrical equipment for measurement, control, and laboratory use.

Equipment Type
Test and measuring equipment.

Safety Class
Class 1 – grounded product.

Pollution Degree Description
A measure of the contaminants that could occur in the environment around and within a product. Typically the internal
environment inside a product is considered to be the same as the external. Products should be used only in the environment
for which they are rated.

Pollution Degree 1. No pollution or only dry, nonconductive pollution occurs. Products in this category are generally
encapsulated, hermetically sealed, or located in clean rooms.

Pollution Degree 2. Normally only dry, nonconductive pollution occurs. Occasionally a temporary conductivity that is
caused by condensation must be expected. This location is a typical office/home environment. Temporary condensation
occurs only when the product is out of service.

Pollution Degree 3. Conductive pollution, or dry, nonconductive pollution that becomes conductive due to condensation.
These are sheltered locations where neither temperature nor humidity is controlled. The area is protected from direct
sunshine, rain, or direct wind.

Pollution Degree 4. Pollution that generates persistent conductivity through conductive dust, rain, or snow. Typical
outdoor locations.
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Pollution Degree
Pollution Degree 2 (as defined in IEC 61010-1). Note: Rated for indoor use only.

Installation (Overvoltage) Category Descriptions
Terminals on this product may have different installation (overvoltage) category designations. The installation categories are:

Measurement Category IV. For measurements performed at the source of low-voltage installation.

Measurement Category III. For measurements performed in the building installation.

Measurement Category II. For measurements performed on circuits directly connected to the low-voltage installation.

Measurement Category I. For measurements performed on circuits not directly connected to MAINS.

Overvoltage Category
Overvoltage Category II (as defined in IEC 61010-1)
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Environmental Considerations
This section provides information about the environmental impact of the product.

Product End-of-Life Handling
Observe the following guidelines when recycling an instrument or component:

Equipment recycling. Production of this equipment required the extraction and use of natural resources. The equipment
may contain substances that could be harmful to the environment or human health if improperly handled at the product’s
end of life. In order to avoid release of such substances into the environment and to reduce the use of natural resources,
we encourage you to recycle this product in an appropriate system that will ensure that most of the materials are reused
or recycled appropriately.

This symbol indicates that this product complies with the applicable European Union requirements according
to Directives 2002/96/EC and 2006/66/EC on waste electrical and electronic equipment (WEEE) and
batteries. For information about recycling options, check the Support/Service section of the Tektronix Web
site (www.tektronix.com).

Perchlorate materials. This product contains one or more type CR lithium batteries. According to the state
of California, CR lithium batteries are classified as perchlorate materials and require special handling. See
www.dtsc.ca.gov/hazardouswaste/perchlorate for additional information.

Restriction of Hazardous Substances
This product has been classified as Monitoring and Control equipment, and is outside the scope of the 2002/95/EC RoHS
Directive.
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Preface

Preface

Documentation
This manual describes the installation and operation of the DSA8300 Digital Serial Analyzer including basic operation and
concepts. For more detailed information, see the online help on your instrument.

NOTE. The screen images in this manual may differ slightly from other versions of product software.

Additional information is available through a variety of sources. The following table points to the location of different types of
information available for this product.

Type of information Location
Unpacking, installation, operation and overviews Quick Start User Manual
In-depth operation, UI help, programming help Instrument online help
Performance verification and specifications Product documentation CD
Product software Product software CD

www.tektronix.com/software
Service Service manual
PDF files of instrument and modules manuals Product software CD

www.tektronix.com/manuals

Conventions Used in This Manual
The following icons may be used in this manual.

Rear panel
power

Front panel
power

Connect power Network PS2 USB
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Key Features

Key Features
The DSA8300 is a state-of-the-art equivalent time sampling oscilloscope that provides the highest fidelity measurement
and analysis capabilities for communications signal analysis, serial data network analysis, and serial data link analysis
applications.

Highest Fidelity Signal Capture
Very Low Time-base Jitter:

425 fs typical on up to 8 simultaneously acquired channels

<200 fs typical on up to 6 channels with 82A04 phase reference module

Best vertical resolution (16 bit A/D):

Electrical resolution: <20 μV LSB (for 1 Vfull range)

Optical resolution depends on the dynamic range of the optical module ranges from <20 nW for the 80C07b (1 mW
full range) to <0.6 μW for the 80C10b (30 mW full range)

Flexible Configurations
The DSA8300 supports up to 8 simultaneously acquired signals

A wide variety of optical, electrical, and accessory modules to support your specific testing requirements

Optical Modules
Fully integrated optical modules that support all standard optical data rates from 155 Mb/s to 100 Gb/s

Certified optical reference receivers support specified requirements for standards-mandated compliance testing

Optical bandwidths to >80 Ghz

High optical sensitivity and low noise as well as the wide dynamic range of the optical sampling modules allows accurate
testing and characterization of short-reach to long-haul optical communications standards

Fully calibrated clock recovery solutions; no need to manually calibrate for data pick-off losses

Calibrated extinction ratio measurements ensure repeatability of extinction ratio measurements to <0.5 dB among
systems with modules with this factory calibration option

Electrical Modules
Electrical bandwidths to >70 Ghz

Very low-noise electrical samplers (280 μV at 20 Ghz, 450 μV at 60 Ghz, typical)

Selectable bandwidths (module 80e07, 08, 09, 10) allow the user to trade-off sampler bandwidth and noise for optimal
data acquisition performance
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Remote samplers (module 80e07, 08, 09, 10) or compact sampling extender module cables support minimal signal
degradation by allowing the sampler to be located in close proximity to the device under test

World’s highest-performance integrated TDR (10 ps typical step rise time) supports exceptional impedance discontinuity
characterization and high dynamic range for S-parameter measurements to 50 Ghz

Analysis
Standard Analysis Capabilities:

Complete suite of over 120 automated measurements for NRZ, RZ, and Pulse signal types

Automated mask testing with over 80 industry-standard masks. New masks can be imported into the DSA8300 to
support new emerging standards. In addition, users can define their own masks for automated mask testing

Vertical and Horizontal histograms for statistical analysis of acquired waveforms

Vertical, Horizontal, and Waveform cursors (with measurements)

Jitter, Noise, BER, and Serial Data Link Analysis is provided through the 80SJNB Basic and Advanced software
application options

Advanced TDR Analysis, S-parameter measurements, Simulation Model Extraction, and Serial Link Simulation
capabilities are provided through the IConnect® Software application options

High Test Throughput
High Sample Acquisition Rate up to 200 kS/s per channel

Efficient Programmatic Interface (IEEE-488, Ethernet, or local processor access) enable High Test Throughput
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Install Your Instrument

Install Your Instrument
Unpack the instrument and check that you received all items listed as Standard Accessories. Recommended accessories
and probes, instrument options, and upgrades are listed in the online help. Check the Tektronix Web site (www.tektronix.com)
for the most current information.

Standard Accessories
Accessory Tektronix part number
DSA8300 Digital Serial Analyzer Quick Start User Manual 071-2897-XX
Certificate of Traceable Calibration for product at initial shipment Not orderable
Business reply card Not orderable
Microsoft Windows compatible keyboard 119-B146-00
Microsoft Windows compatible mouse 119-6936-00
Instrument front cover 200-4519-00
Accessory pouch 016-1441-00
Touch screen styluses (2) 119-6107-00
ESD wrist strap with 6 foot coiled cord 006-3415-04
DSA8300 Product Documentation Kit (CD) 020-3082-XX
DSA8300 Online Help (part of application software) Not orderable
DSA8300 Programmer Online Manual (part of application software) Not orderable
DSA8300 Product Software Install Kit 020-3088-XX
DSA8300 Operating System Restore Kit 020-3089-XX
Power cord Type dependent on selection

during order placement
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Operating Considerations
The following information lists the specifications related to the operation of the mainframe. Refer to the DSA8300 Digital
Serial Analyzer Specifications and Performance Verification Manual for a complete list of specifications.

Mechanical

Clearance requirements

Top, Front, and Rear: 0 mm (0 in)

Sides: 51 mm (2 in)

Bottom: 19 mm (0.75 in)

Dimensions

Weight 19.5 kg (43.0 lb.). This does not include any accessories or modules.

Orientation Place the instrument on a cart or bench. The instrument should rest on its
bottom or rear feet. The front feet fold down to angle the instrument.

Rack mounting An optional rack mounting kit (Option 1R) is available.

Environmental

Temperature 10 °C to +40 °C

Relative humidity 20% to 80%, with a maximum wet bulb temperature of 29 °C at or below
+40 °C

Altitude 3,000 m (9,843 ft.)
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Power Supply

Source voltage and Frequency 100 - 240 VRMS ±10%, 50 - 60 Hz or 115 VRMS ±10%, 400 Hz

Power Consumption 600 watts maximum
Typically, 240 watts (fully loaded); 160 watts (mainframe with no modules)

Input Connectors

Trigger Direct Input range ±1.5 V (DC + peak AC) maximum input voltage

Trigger Prescaled Input absolute maximum
input (typical)

±1.1 Vp-p

External 10 MHz Reference Input 500 mVp-p to 5 Vp-p AC coupled into 1 kΩ, ±5 V maximum
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Installing Modules

CAUTION. To prevent damage to modules, do not transport or ship the instrument with modules installed. Modules are
also sensitive to electrostatic discharge (ESD). To avoid ESD damage, always use an ESD wrist strap when installing or
removing modules and when connecting signals to the module inputs. Never install or remove modules while the instrument
is powered on.

1. Always use an ESD wrist strap (provided)
when installing and removing modules.

2. You can install up to two large sampling
modules and four small modules for a
total of 8 inputs.

Following are some typical module installations illustrating the interaction between large compartment channels and small
compartment channels.

NOTE. A large compartment module that only derives power from the compartment does not use any small compartment
input channels.

Eight channels: No large and four small
modules

Six channels: Two large modules and two
small modules

Seven channels: One large module, installed
in CH3 compartment, and three small
modules

Seven channels: One large module, installed
in CH1 compartment, and three small
modules
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Powering the Instrument On and Off

1. Insert AC power cord.

2. Toggle the mains switch to on.

3. Use the front panel power button to
switch the instrument on and off.

CAUTION. To prevent damaging the modules, do not install or remove any modules while the instrument is powered on.

Adding a Second Monitor
You can add a second monitor to provide two screens for viewing instrument applications or readouts.

1. Power off the instrument.
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2. Connect a video cable (not supplied)
from the DVI-I out video port on the back
of the instrument to the DVI-I port on the
external monitor.

NOTE. Use a DVI-I to SVGA adapter (not
supplied) to connect to SVGA monitors.

3. Power on the instrument.

4. Power on the external monitor. The
instrument detects the external monitor
and displays the contents of the
instrument screen.

5. Move the cursor to a blank area of the
screen, right-click the mouse to open
the context menu, and select Graphics
Properties.
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6. Select the display mode from the
Operating Mode list.

7. If using an extended desktop, click the
external monitor 2 box in the Position
pane and drag the monitor to the position
that relates to the physical position of
monitor 2 in relation to monitor 1.

8. Click the Display Settings tab, click the
Digital Display tab, and use the fields to
set the monitor 2 screen characteristics.

9. Click Apply. The instrument makes the
selected changes and then prompts you
to keep the changes (if OK) or to Cancel
the settings and return to the previous
settings. If the new settings are correct,
click OK. You have about 15 seconds
before the instrument automatically
returns to the previous display settings.

10. Click OK to close the Intel Graphics
Media Accelerator Driver window.
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Getting Acquainted with Your Instrument

Front Panel
The front panel of your instrument gives you access to the module compartments and the control panel.

1. Antistatic connection terminal (1 MΩ).

2. On/Off switch.

3. Clock Input/Prescale Trigger input.

4. Trigger direct input.

5. Trigger probe power.

6. External 10 MHz reference input.

7. DC calibration output.

8. TDR Clock Out signal.

9. USB port.

10. Control panel.

11. DVD/CDRW drive.
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Control Panel

1. Access print dialog box for printing the display.

2. Optimize instrument settings for the selected channel to automatically display a waveform.

3. Quickly return the instrument to default control settings.

4. Display measurement cursors and assigns the knob and SELECT buttons to control them.

5. Menu buttons quickly access the setup dialog box for more detailed setup.

6. Clear all data and measurement results.

7. Adjust most control fields in setup dialogs. Push the SELECT button to select the active cursor (when cursors are
enabled). Push the FINE button to toggle between normal and fine adjustment.

8. Start and stop acquisition.

9. Display the Setup dialog box for comprehensive setup of the instrument.

10. Toggle the touch screen on and off. Use the touch screen to control UI when you have not installed a mouse.

11. Select a waveform type (Channel, Reference, or Math) to display or adjust on screen (selected button lights).

12. Push a channel button to select and display a waveform for that channel. A lit button indicates selected and displayed
waveforms for that channel. An unlit button indicates that the channel is not selected.
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13. Select among displayed timebase views or display and select a magnified timebase view. Push the selected view to
turn it off (except main, which is always on).

14. Vertically scale, position, and offset selected waveform.

15. Horizontally scale, position, and set record length of selected waveform.

16. Set trigger level (applies only to Trigger Direct Input) and use lights to monitor trigger state.

Rear Panel
The rear panel of your instrument allows you access to input and output connectors and the AC input.

1. Removable hard drive.

2. GPIB port. The instrument is factory set to be a talk/listen device, allowing you to control the instrument via the GPIB
port. You can change the instrument to be a GPIB controller, allowing you to control other devices via the GPIB port, or
set the instrument to be off bus. Refer to the Programmer Manual installed on the instrument.

3. Computer I/O panel. (See page 13, Computer I/O Panel.)

4. AC input.

5. Fuses.

6. Mains power switch.
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Computer I/O Panel

1. Audio line out 2. Mic input 3. USB ports
4. DVI-I video out for dual-monitor display 5. COM1 6. PS2 (keyboard)
7. PS2 (mouse) 8. COM2 9. LAN
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The User Interface

1. Measurements Bar. Access to automated measurements by signal type and category; click measurement buttons to
measure the selected waveform.

2. Tool Bar. Access to key features including printing, setup dialogs, math waveform setup, waveform database, autoset,
clear data, acquisition mode, triggering, and applications.

3. Menu Bar. Access to data I/O, printing online help system, and setup functions.

4. Status Bar. Waveform count and trigger/acquisition status.

5. System Time/Date and compensation status.

6. Readout Docking. Select to undock the readout area from the application.

7. Readout area. Displays waveform and measurement details. Use the arrow buttons at each end to scroll the contents.

8. Readout. Right click on a readout to display a context menu for additional settings for that readout category.

9. Readout Enable. Toggles the readout type (cursor, histogram, mask, measurement, and waveform) on or off.

10. Controls Bar. Click to select a waveform (channel, math, or reference), as well as quick access to scale, offset, and
position controls for adjustment.

11. Display. Contains live, reference, and math waveforms, and histograms, cursors and test masks when enabled.
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Display - Single Waveform View

1. Drag the Horizontal Reference to move the point around which the horizontal scaling expands and contracts the
waveforms.

2. Drag cursors to measure waveforms on screen.

3. Drag the waveform icon vertically to position waveform.

4. Right-click on a waveform or its icon to open the context menu with setup controls and properties.

5. Drag ground reference icon to add offset to a waveform.

6. Drag across the waveform area to horizontally zoom the boxed waveform segment to full screen width.
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Display - Magnified Waveform Views

1. MAIN View.

2. Mag1 View.

3. Mag2 View.

4. Drag the markers to enclose the portion of waveform to appear in Mag1 View.

5. Drag the markers to enclose the portion of waveform to appear in Mag2 View.

6. Drag the border between graticules to vertically size Main, Mag1, and Mag2 Views.
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Accessing Online Help
In-depth information about all the features of your instrument is available in the online help.

Position the mouse cursor on a control,
such as a menu name, a menu item, toolbar
button, or toolbar readout. The help system
displays a short definition or description
(tooltips) of the control.

For in-depth, contextual overviews, most
dialog boxes have a Help button. Click
the button to open the help system for
information on that dialog box.

Select Help > Help Contents and Index to
open the overall help system.
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Inspect Your Instrument
Use the following procedure to verify the functionality of your instrument. For a complete performance verification, see the
DSA8300 Digital Serial Analyzer Performance Verification and Specifications Manual, which can be downloaded from the
Tektronix Web site.

Verify Internal Diagnostics Pass
1. Install all modules to be diagnosed.

2. Power on the instrument and wait
20 minutes for the warm-up period.

3. Select Utilities > Diagnostics.
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4. Select the Subsystem Level tab.

5. Select all the entries by clicking the first
entry Control Proc and dragging down
to select the rest. All entries should be
highlighted.

6. Verify that the Loop and Halt on Failure
boxes are unchecked.

7. Click Run.

8. Verify that all tests display Pass in the
Status column when the diagnostics
complete. If diagnostic failures occur,
contact your local Tektronix service
center.
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Optimizing Measurement Accuracy
The instrument provides several utilities that optimize measurement accuracy:

Signal path compensation (SPC) configures signal paths to improve measurement accuracy at the current ambient
temperature.

Dark-level compensation maximizes the accuracy of extinction ratio and other optical measurements

User Wavelength Gain compensation optimizes an optical channel for a custom input signal

Signal Path Compensation
Signal path compensation (SPC) configures the instrument and module signal paths to make accurate measurements at
the current ambient temperature.

You should run a SPC:

After adding a module to the instrument

After adding or removing an extender cable from a module.

After moving a module to another slot.

The ambient temperature has changed more than 5 °C since the last signal path compensation.

When making measurements at vertical scale settings less than or equal to 5 mV/div. Perform the signal path
compensation once a week under these conditions. Failure to do so may result in the instrument not meeting warranted
performance levels at these volts/div settings.

NOTE. You must save the compensation results or they will be lost when the instrument is powered down.

After installing a module or moving a module to another compartment, you must power on the instrument and allow the
temperature (of the instrument and module(s)) to reach a stable equilibrium (normally 20 minutes).

1. Install all modules to be compensated.

2. Install all terminations and dust covers.
Failure to install the 50 Ω terminations
on electrical inputs can cause erroneous
compensation failures or results.

3. Power on the instrument and wait
20 minutes for the warm-up period.
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4. Select Utilities > Compensation

5. Verify that the main instrument
(mainframe) and all installed modules
are listed. The temperature change from
the last compensation is also listed.

6. Check that the Status for all items to
compensate changes from Warm Up to
Pass, Fail, or Comp Req'd.

7. Select Compensate and Save (default).

8. Select the item on which to run
compensation:

Mainframe (default selection) to
compensate just the main instrument

All modules to compensate all installed
module channels

Module to compensate specified
channels of the selected module

9. Click Execute.
Follow the on-screen instructions
regarding signal and trigger inputs
and terminations; be sure to follow
electrostatic handling precautions
(see the user information for your
sampling module) when following these
instructions.
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10. Verify that the compensation routines
pass.
If the status is Fail, run the compensation
again. If Fail status continues, the
module or main instrument may need
service.

11. Use the Compensation Indicator Button
to display or hide the compensation
indicator on the main display. Green
means that all modules have been
successfully compensated. Yellow
means that the instrument has not
competed its 20 minute warm-up period.
Red means that one or more modules
require compensation.
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Dark-Level and User Wavelength Gain Compensations

NOTE. You should run the Signal Path Compensation procedure before running dark-level or user wavelength gain
compensation. (See page 20, Signal Path Compensation.)

These procedures apply only to optical modules.

Dark-level compensation maximizes the accuracy of the extinction ratio and other optical automatic measurements.
Dark-level compensation performs a subset of the module compensation process. It is designed to be fast so it can be
performed frequently, just before measurements are taken. Dark-level compensation is not saved and is only valid for the
selected bandwidth or filter path and the internal optical power meter.

User Wavelength Gain compensation optimizes an optical channel for your custom input signal.

1. Install one or two optical sampling
modules in the instrument. Set the
acquisition system to run continuously.

2. Select the channel to compensate.

3. Select Setup > Vertical.
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To run the Dark-Level compensation:

4. In Vert Setup dialog box, click the Dark
Level button under Compensation.
Follow the instructions on screen.

NOTE. You need to switch from the Basic
dialog to the Optical dialog to access the
Dark Level Calibration button.

Repeat steps 2 and 4 for any
additional optical channels you want to
compensate.

To run the User Wavelength Gain
compensation (for signals at wavelengths
other than the factory calibrated values;
typically 850, 1310 and/or 1550 nm):

5. Use an independently-calibrated average
optical power meter to measure the
power of an optical signal source.
Then connect the signal to the optical
module using the same fiber cable.

6. Click the User Wavelength Gain button
in the Vert Setup dialog box.

7. Enter the wavelength and measured
power of the signal applied to the
channel In the User Wavelength Gain
Compensation dialog box.

8. Click OK to execute the compensation.
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Acquisition
This section contains concepts of and procedures for using the acquisition system. Detailed information is available in the
online help.

Setting Up Signal Input
Use front-panel buttons to set up your instrument to acquire the signal.

CAUTION. Sampling modules are inherently vulnerable to static damage. Always observe static-safe procedures and
cautions as outlined in your sampling-module user manual.

1. Connect the instrument to the device or
signal under test using proper probing
or connecting techniques. See the user
manual for the installed sampling module
for connection requirements.

CAUTION. Discharge electrical cables to
ground before connecting them to a module.

2. Connect an appropriate trigger signal to
the instrument. (See page 35, Triggers.)
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3. Push the CH button (turns amber) to
assign the waveform buttons (1 – 8) to
operate on channel waveforms. Then
select the proper waveform button.
A waveform button lights when its
channel is on; when on but not selected,
the button is green; when on and
selected, the button is amber.
Push the MATH button to assign the
waveform buttons to math waveforms.
If the selected math waveform is not
defined, the instrument opens the Define
Math dialog box.
Push the REF button to assign
the waveform buttons to reference
waveforms. If no reference waveforms
are loaded into the channels, the Recall
Waveform dialog box appears.

4. Use the Vertical Position, Offset,
and Scale knobs to adjust the vertical
parameters of the selected waveform.
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5. Push the View Main button to make sure
that the main time base view is selected.
Use the horizontal Position, Resolution,
and Scale knobs to scale and position
the waveform on the screen and to set
the sample resolution.

Quick Tips
You can click a waveform trace or its reference indicator with the mouse pointer (or touch screen) to select it.

Push AUTOSET to quickly set up instrument parameters and display a waveform based on the input signal.

Push Set to 50% in the Trigger controls, if required, to stabilize the display when using the Trigger Direct Input connector.

Using Factory Default Setup
1. To quickly return to the factory default

settings, push DEFAULT SETUP.

2. Click Yes to restore the settings.
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Using Autoset
Use Autoset to automatically set the instrument vertical, horizontal, and trigger parameters and display a waveform based on
the characteristics of the input signal.

NOTE. Make sure that the input channel(s) for the signal are on and selected before doing an autoset.

1. Push the AUTOSET button to execute
an Autoset.
If you use Autoset when one or more
channels are displayed, the instrument
uses the selected channel for horizontal
scaling. Vertically, all channels in use are
individually scaled.

Quick Tip
If the instrument does not autoset to your signal, select Setup > Horizontal, click the Comm Standard button, and
select the signal type. Then push the Autoset button again.

Select Utilities > Define Autoset to change the Autoset properties.
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Accessing the Setup Dialog Boxes
The Setup dialog boxes are the key controls for setting instrument parameters such as Mode/Trigger, horizontal, vertical,
acquisition, cursors, histogram, display, and mask.

1. Access the Setup dialog boxes by using
the front panel buttons, the Setup menu
item, or the Setup button.

2. Click on the tabs to select among the
setup dialog boxes.
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Changing the Acquisition Mode
Use the procedure that follows to set the data-acquisition mode and specify acquisition start and stop methods.

1. Push the Acquisition MENU button to
display the Acq Setup dialog box.

2. Select the acquisition mode.

3. For Average mode, enter the number of
samples to average.

4. Set the Stop After mode and action by
selecting Run/Stop Button Only or
Condition.

5. If you selected Condition, choose a
condition on which to stop from the
drop-down list. If the condition requires a
count, enter a count.

6. Enter a filename if you selected Print to
File or Save all Waveforms.

7. Select Ring Bell if you want the
instrument to produce an audio tone
when the acquisition stops.

NOTE. You must connect an external
speaker to the instrument to hear a tone on
a stop condition.
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8. Push RUN/STOP to start the acquisition.

9. Push RUN/STOP again to stop the
acquisition.

Quick Tips
Run/Stop is available on both the front panel and the touch screen.

If Stop After is set to Condition, pressing RUN/STOP causes only one acquisition to run if the original condition has been
met. You need to push CLEAR DATA so that the condition must be met again.
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Waveform Databases

NOTE. Certain measurements require the use of a waveform database. The instrument automatically sets the measurement
system to use a waveform database if one is available.

The four available waveform databases can be used for measurements, histogram calculations, mask testing, and generating
a density-style, graded display. Waveform databases may be automatically allocated for measurements, histograms, and
mask testing.

1. Select Setup > Wfm Database from the
main menu.

2. From the pulldown menu under
Database, select one of the four
available databases.

3. Click the Source button to select the
waveform source.

4. Click On to start accumulating data from
the selected source.

5. Click Display to turn on the display of
the waveform database.

6. Select the Persistence mode for the
selected waveform.

7. If you selected Variable persistence, you
can specify the number of waveforms
that are included in the waveform
database.

The following Display Options affect all
waveform databases that you display:

8. Click a grading display option.

9. Click Invert to emphasize the least
occurring pixels by reversing the
intensity/color assignments to each
grading partition.

10. Select one of the four grading methods.

11. If you selected one of the two
Emphasized grading methods, slide the
Emphasize Counts percentage control
to specify the range of counts you want
emphasized.
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Setting the Display Style
1. Click the Setup button and click the Disp

tab.

2. Select a waveform display style.
Normal selects a display with no
acquisition data persistence. Waveforms
are displayed with the new data from
ongoing acquisitions replacing data
acquired from previous acquisitions.

Show Vectors turns on display lines
between waveform dots; deselect to
display only dots.

Sin(x)/x interpolation computes
record points using a curve fit
between the acquired samples.

Linear interpolation computes
record points between actual
acquired samples by using a straight
line fit.

3. Variable Persistence makes data
persist for a specified time. New
waveform displays accumulate data as
new waveform records acquire, but with
continuous replacement of the oldest
data.
Set a time at which the oldest data is
removed.
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Infinite Persistence makes data
persist until you change some control
or explicitly clear the data. Waveform
displays accumulate data as the
instrument acquires new data, resulting
in a buildup of data in all time slots.

4. Use the Graticule settings to select the
graticule style and the graticule color and
screen background.
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Triggers
This section contains concepts and procedures for using the trigger system. Detailed information is available in the
online help.

Triggering Concepts
Trigger Event
A trigger event occurs when the trigger source (the signal that the trigger circuit monitors) passes through a specified voltage
level in a specified direction (the trigger slope). The trigger event sets the time-zero point in the waveform record and all
sampled waveforms on all inputs are measured with respect to that event.

When a trigger event occurs, the instrument acquires one sample of all active (selected) signals. When the next trigger
event occurs, the instrument acquires the next sample. This process continues until the entire record is filled with acquired
samples. Without a trigger, the instrument does not acquire any samples. Sampling oscilloscope behavior differs from that of
real-time acquisition systems, which can acquire a complete waveform record from a single trigger event.

Trigger Sources
The trigger source sets the source that the trigger system monitors for a trigger event. The source can be:

A clock signal used for acquiring optical or electrical serial data streams. The source of the clock can be internal or
external to the instrument:

External Clock Input/Prescale Trigger. Connect the trigger signal to the front panel connector. Triggering is
guaranteed for clocks from 150 Mb/s up to 15 Gb/s (and will typically work up to 20 Gb/s).

Internal Clock-recovery trigger. This trigger source can be an optical sampling module that is equipped with a
clock-recovery option, or a dedicated electrical clock recovery module. Available clock recovery triggering rates
depend on the sampling module. For example, the 80C08C Optical Sampling Module with option CR4 provides
internal clock-recovered triggers for any data rate (standard or custom) from 8.5 Gb/s to 12.5 Gb/s.

The instrument TDR clock, with selectable TDR Step repetition rates. The TDR CLOCK OUT connector on the
instrument front panel supplies a replica of the TDR clock,

A low-repetition rate signal (DC to 3 GHz) connected to the External Trigger Direct input. While this trigger source can be
used to acquire serial data signals at rates up to 3 Gb/s, its primary use is for low repetition rate (<150 MHz) signals or for
signals where you need additional conditioning of the input trigger signal (such as trigger level, slope, and so on). This
flexibility comes at the cost of increased instrumentation jitter.

An internal clock for Free Run acquisition of signals. (Since the acquired signals are not synchronous with the trigger,
this trigger source is useful primarily for locating a signal or clock and applying the appropriate offset to the data or
trigger for proper synchronous waveform acquisition.)
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Trigger Modes
When a Clock source is selected (whether Internal Clock recovery or external Clock Input/Prescale Trigger input) as the
trigger source, you must select the Trigger Mode. Available trigger modes are Eye, Pattern, and Other:

Select Eye mode if the signal you are acquiring is synchronous with the selected clock source and you want to display
the acquired data as an "eye diagram" overlaying all of the acquired data bits with minimal clock to data jitter.

Select Pattern mode if the signal you are acquiring is synchronous with the selected clock source and you want to
display the individual bits as a "bit stream", with minimal clock to data jitter.

NOTE. This mode is only available if the ADVTRIG option is present on the instrument.

Select Other mode if the signal you are acquiring is synchronous with the selected clock source and you want to display
the acquired data showing the effects of any clock modulation (such as Spread Spectrum Clocking).

Table 1: Application-based trigger modes
Application Waveform display Trigger Source/Mode
Optical or
Electrical Serial
Data (NRZ) Mask
and Parametric
Testing (minimum
jitter)

Trigger Source: Clock Input/Prescale Trigger input or
Internal Clock Recovery

Clock Trigger Mode: Eye

Optical or
Electrical Serial
Data Pattern
Analysis (including
JNB analysis)

Trigger Source: Clock Input/Prescale Trigger input or
Internal Clock Recovery

Clock Trigger Mode: Pattern (this mode of operation
requires the Advanced Trigger Option ADVTRIG).
Maximum supported pattern length= 223.

Optical or
Electrical Serial
Data (NRZ) Mask
and Parametric
Testing (w/ clock
modulation effects
– SSC)

Trigger Source: Clock Input/Prescale Trigger input or
Internal Clock Recovery

Clock Trigger Mode: Other

Clock Signal
Analysis

Trigger Source: Clock Input/Prescale Trigger input or
Internal Clock Recovery

Clock Trigger Mode: Eye
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Table 1: Application-based trigger modes (cont.)

Application Waveform display Trigger Source/Mode
TDR/TDT and
S-Parameter
Analysis

Trigger Source: TDR

Low Repetition
Rate Signals

Trigger Source: External Direct Trigger input
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Setting Trigger Controls
Nearly all trigger parameters are set in the Mode/Trig Setup dialog box.

1. Push the Trigger MENU button to display
the Mode/Trig Setup dialog box.

2. Select a trigger source.

3. If the trigger source is Clock, select
theScope Mode.

4. Use the Clock Recovery Outputs fields
to select a measurement standard and
define clock recovery parameters on
applicable modules.

5. Click Pattern Sync/FrameScan Setup
to set pattern sync, autosync and
FrameScan parameters. (See page 39,
Setting Pattern Sync and FrameScan
Controls.)

6. Click Advanced Trigger Setup to set
trigger level, slope, holdoff, and other
trigger parameters.

Quick Tips
Selecting Clock > Prescale/Clock as the trigger source requires that an appropriate trigger signal be connected to the
CLOCK INPUT/PRESCALE TRIGGER input connector.

If you select the Clock trigger source, you also need to select the Scope Mode (Eye, Pattern, or Other).

Pattern (Scope Mode) triggering is only available if the Advanced Trigger option ADVTRIG is installed on the instrument.

If you select Pattern (Scope Mode), use the Pattern/Sync/FrameScan Setup dialog to specify the pattern characteristics.

Selecting a Clock Recovery trigger source requires that a module with clock recovery is available. Select the clock
recovery standard from the pulldown lists or user-specified range controls.

Selecting TDR as the trigger source uses the clock frequency setting in the Rate control.
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Selecting Direct as the trigger source requires an appropriate trigger signal be connected to the DIRECT INPUT
connector.

The Level control applies only when the trigger source is set to Direct.

Setting Pattern Sync and FrameScan Controls

NOTE. The pattern sync controls are only available if the instrument has the ADVTRIG option installed and the instrument is
set up for Pattern Trigger mode.

1. Select Setup > Mode/Trigger.

2. Click Pattern Sync/FrameScan Setup.

3. Select the parameters for pattern
synchronization:

Select the Data Rate (bit rate) (default
is 2.48832 Gb/s).

Select the Pattern Length (default is
127).

Select a Data:Clock Ratio
(data-to-clock ratio) (default is
1:1).

Set the Main timebase delay position.
This is the same control as found in
the Setup > Horizontal tab.

4. Use the AutoSync feature to
automatically detect the data rate,
pattern length and/or data-to-clock ratio
of the applied data and clock signals
(data to a sampling module channel and
the clock to the Clock/Prescale Trigger
input, or from an internal clock recovery
source).

5. Enable FrameScan to automatically scan
through a pattern (or part of a pattern).
This FrameScan control is the same as
the FrameScan control in the Horizontal
Setup dialog box (changing either one
affects the other).
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Quick Tips
All pattern sync controls are disabled (grayed out) if the Advanced Trigger option (ADVTRIG) is not enabled in the
instrument or the trigger source mode is not Pattern.

The Data Rate in the Pattern Sync dialog box is tied to the Bit Rate control in the Horizontal setup dialog box. Changing
either one affects the other.

If the entered Data Rate does not match the rate of the selected communication standard in the Horizontal Setup,
then the communication standard is changed to User.

For highest reliability and speed, manually enter as many control values as possible. Uncheck the control value in the
AutoSync Options area to enable manual entry.

Checking Trigger Status
You can check the status of the trigger from the front panel and in the application status bar. The status bar also displays
the waveform count.

1. Check the READY and TRIG'D
front-panel controls to determine the
trigger status, or look at the trigger status
in the application.
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Waveform Measurements
Your instrument features automatic measurements (with statistics), cursors, histograms, and waveform math processing
to assist you in analyzing waveforms. This section contains concepts and procedures for analyzing waveforms. See the
online help for more information.

Taking Automatic Measurements
Automated measurements are divided into waveform types (Pulse, NRZ (Non-Return-to-Zero), and RZ (Return-to-Zero))
and measurement categories (amplitude, time, and area).

1. Select the waveform to measure. You
can measure a channel, reference, or
math waveform.

2. Select the waveform type and category
from the buttons on the Measurement
bar.

3. Click on a measurement button in
the Measurement tool bar. The
instrument displays the most frequently
used measurements for the selected
waveform type and category.
You can also access all of the
measurement types from the MEAS
setup dialog box.
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4. Read the results in the measurements
readout.

To see statistics:

5. Right click on any measurement readout
to display its context menu.

6. Select Show Statistics to display
measurement statistics in the
measurement readout.

To show measurement annotations:

7. Right click on any measurement readout
to display its context menu.

8. Select Show Annotations to display
annotations that indicate which portion of
the waveform is being measured as well
as reference levels for the measurement.

9. Note the portion of the waveform being
measured.

10. Note the reference levels for the
measurement.
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To measure a waveform database:

11. Select Setup > Meas from the application
menu bar.
In the Meas Setup dialog box, make sure
to select a measurement slot (one of
Meas 1 through Meas 8).

12. In the Source tab, check the Use Wfm
Database option.

To localize a measurement:

13. Select Meas.

14. Select the Region tab.

15. Click the On box to turn gating on and to
display the gates on screen.

16. Use the G1 (Gate1) and G2 spin controls
to adjust the gates on screen such that
the area to measure is between the
gates.
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17. Click the Annotations box to display
which portion of the waveform is being
measured and the reference levels for
that measurement.

Quick Tips
If, at the time you first create a measurement, the measurement source you select is displayed as a waveform database,
the database will automatically be measured. Deselect the User Wfm Database option if you want to measure the
vector waveform instead of the database.

Gate values are entered as a percentage of the waveform, displayed from left to right. If no keyboard is installed, access
the virtual keyboard and use the touch screen to enter values.

You can select and drag the gates to new locations by using a mouse or the touch screen.
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Turning Off Automatic Measurements
You can assign and display up to eight automatic measurements. If you need an additional automatic measurement, and all
measurement slots are used, reassign a current measurement slot to the new measurement.

1. Note the current measurement
assignments. In this example,
measurement slots 1 and 3 have
measurements assigned and displayed.

2. Select Meas (measurement) from the
Setup dialog box.

3. Use the pulldown list to select Meas 3
(measurement slot 3).

4. Note that measurement slot 3 has a
measurement assigned and is displayed
(On).

5. Click Select Meas > None to disable
measurements on slot 3.

6. Note that measurement slot 3 is
now labeled Not Defined and no
measurement icon is displayed.
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7. Note that measurement slot 1 has a
measurement assigned. It is set to not
display, but the measurement slot is still
used.

Quick Tip
To easily redefine a measurement slot, select Select Meas and choose a new measurement.

Cursor Measurements
Use cursors to measure amplitude and time quickly and with more accuracy than when visually using the graticule to
take measurements. Because you position cursors wherever you want on the waveform, they are easier to localize to a
waveform segment or feature than automatic measurements.

1. Push the CURSORS button:

Once for Vertical Bars

Twice for Horizontal Bars

Three times for waveform cursors

2. Push the SELECT button to toggle
selection between the two cursors. The
active cursor is represented by a solid
line.

3. Turn the General Purpose knob to
position each cursor on the waveform to
measure the feature that interests you.

4. Vertical bars (V Bars) measure horizontal
parameters (time, bits or distance).
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5. Horizontal bars (H Bars) measure
amplitude parameters (volts, watts,
ohms, rho).

6. Waveform cursors measure vertical and
horizontal parameters simultaneously.
Waveform cursors are attached to the
waveform and track with the waveform
points.

7. Read cursor measurement results in the
readouts area of the display.

8. Click this button to show or hide the
cursor readouts.

Quick Tips
Cursors require that at least one waveform is selected on the screen.

Waveform cursors are not available if a waveform database is selected.

You can drag a cursor to place it relative to the waveform.
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You can assign each cursor to a different waveform to measure differences between waveforms. Make these selections
in the Cursor setup dialog box.

If you use two magnified time base views, you can take precision timing measurements between two distant points on a
waveform. Magnify each point of interest in a separate time base, and then place one cursor on each point. The Δ-time
cursor readout will then reflect the position and resolution of the magnified time bases.

Math Waveforms
You create math waveforms by creating a math expression using the Define Math dialog box. In that dialog box, you
apply numerical constants, math operators, and functions to sources (live or reference waveforms), measurement scalars
(measurement readouts), or fixed scalars. You can display and manipulate these derived math waveforms much like you
can the channel and reference waveforms.

1. Push the Vertical MATH button (once or
twice if needed) to display the Define
Math dialog box.

2. Click the Math Waveform drop-down list
in the dialog box and select one of the
eight available math waveforms.

3. Use the dialog box to define a math
expression. Some guidelines for creating
your expression follow:

Sources (C1 - C8, R1 - R8, and
Meas 1 - Meas 8) should be set up
before you use them (references and
automated measurement scalars
should be defined).

Elements that appear grayed out
cannot be selected because they
would result in an illegal entry.

48 DSA8300 Quick Start User Manual



Waveform Measurements

4. Use the filter control in the dialog box to
specify the rise time of any filters in the
math waveform definition.

5. When you have defined the expression,
click Apply.

6. Select the Math Waveform On box to
display the waveform.

Quick Tip
If you select a waveform that is already defined, its math expression appears in the dialog box. To use the waveform,
click the Clear button, which discards its previous math expression.

Display a Communication Signal

1. Connect signals to the sampling
module (Data signal to the module
input, clock signal to the CLOCK
INPUT/PRESCALER TRIGGER
connector).

CAUTION. Always observe optical cable
and static-safe procedures and cautions
as outlined in your sampling-module user
manual when connecting cables to modules.
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2. Push the DEFAULT SETUP front panel
button and click YES to load the default
instrument setup.

3. Select the input signal source (1–8).

4. Select Setup > Horizontal and enter the
communications standard or set the bit
rate of the signal.

5. Push the AUTOSET front panel button.
The instrument analyses and displays
the signal.
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Mask Testing
Use mask testing to test your waveforms for time or amplitude violations against a predefined industry standard or a
user-defined mask. Mask testing counts waveform samples (called hits or violations) that occur inside of a specific area (the
mask). This instrument provides many predefined standard masks (including Ethernet, SONET/SDH, and Fiber Channel
(Optical and Electrical)). You can also use the mask edit tools to create a custom mask.

1. Select the waveform to be mask tested
from the drop-down list under Source.

2. Select a standard mask in the
Mask setup dialog box. Selecting a
communication standard or user-defined
mask automatically:

Displays the mask on screen and
autosets for the mask if Automatic is
checked in the dialog box.

Enables mask testing.

Displays mask count statistics in
the mask readout. You do not have
to display a mask to enable mask
counting.

3. If you want, disable mask counts.
(Selecting a mask in step 2 automatically
enabled them.)

4. Check Use Wfm Database to use a
waveform database as the waveform
source.

5. You can enable margins to explore
design margins of your communications
signal.
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To autoset the waveform to the mask:

6. Click the Autoset button to perform a
manual autoset on the mask-source
waveform.

7. Select the HiLow Method to determine
the signal High and Low values, used to
align the input signal to the mask:

NOTE. When using a standard mask,
the instrument automatically selects the
appropriate HiLow Method.

Mean sets the Mask Autoset to use the
mean value of the High level (topline)
and Low level (baseline), taken within
the fixed eye aperture (center 20% of the
eye), to align the input signal to the NRZ
mask.
Mode sets the Mask Autoset to use
the High level (topline) and Low level
(baseline), taken across one unit interval
of the eye diagram, to align the input
signal to the NRZ mask.

To set a Stop Action:

8. Select Setup > Acquire in the main
menu to open the Acq setup dialog box.

9. In the Acq Setup dialog box, check the
Condition option under Stop After.

10. In the Condition pulldown list, select
a mask-related criteria, such as Mask
Total Hits and set a count, such as 1, in
the count box.
These settings stop acquisition when
mask violations satisfy the criteria you
set.

11. Push the RUN/STOP button to restart
acquisition, if stopped.
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To restart testing:

12. To restart after a Stop After condition
occurs, push the front-panel CLEAR
DATA button, followed by the RUN/STOP
front-panel button.

13. Read the mask-hits count in the readout.

Quick Tips
Selecting a source that is currently displayed as a waveform database automatically enables mask testing on the
database. To mask test the waveform instead of its database, deselect the Use Wfm Database box.

You can choose to autoset the mask-source waveform to the mask each time you select a new mask standard by
checking Automatic under Autoset.

Pushing the RUN/STOP button after acquisition has stopped due to a Stop After condition being met causes the
instrument to acquire one (and only one) additional waveform.

The Clear Data button resets all mask counts. In addition, if the source for mask testing is a waveform database, clicking
this button clears the waveform database.
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FrameScan
Use FrameScan to test a specific bit (or range of bits) in a repeating frame of data. FrameScan acquisitions allow detailed
display and analysis of individual, complete waveforms or of the bit sequences leading up to a failure. This ability to identify
the specific patterns that caused the failure makes the FrameScan mode superior to traditional methods.

1. Select the Horizontal Setup tab.

2. Click Pattern Sync/FrameScan Setup.

3. Click Enabled in FrameScan.

4. Set the Scan Bits to the number of bits
or subframes to acquire.
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To Use TDR
To take TDR measurements, you must have a TDR-capable sampling module installed and your DUT must be attached to
the TDR sampling module.

1. Select TDR from the Setup menu.

2. Click the channel button to automatically
display the incident and reflected steps
of the selected channel by automating
the following tasks:

Turns on the channel.

Turns on a step.

Sets trigger source to TDR.

Sets acquisition to Averaging.

Changes display style to Show
Vectors.

3. Select a channel pair on which to
perform a differential TDR measurement.
Click Diff to automatically set up the
differential measurement for the channel
pair.
All the tasks listed in step 2 are performed
for both channels and the pulse polarity
of the second channel is set to negative.

4. Click the polarity button to toggle the
step edge.

5. Set the vertical scale Units to V (volts), Ω
(ohms), or ρ (rho).

6. If performing differential TDR, select the
channel (TDR module with dual channel
adjustment) or the even-numbered
channel of the channel pair (TDR module
with single channel adjustment) for
deskew adjustment.

7. Set the Deskew percent value.

8. Click TDR Autoset Properties to display
the Autoset Properties dialog box to
prepare the TDR autoset.
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Quick Tips
Use a lower TDR rate to take measurements on long cables.

For a TDR module with single channel deskew capability, only the even-numbered channel of the module is selectable
for deskew. For a TDR module with dual channel deskew capability, both channels of the module are selectable for
deskew. (See page 61, Skew and Deskewing.)
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Phase Reference
Use the Phase Reference function when you need to minimize instrument trigger jitter. Reducing trigger jitter in the
instrument provides better measurement accuracy when measuring clock and other phase-jitter-vulnerable signals.

NOTE. To use the phase reference function, you must have a phase reference module (such as the Tektronix 82A04), and a
phase reference clock signal that is synchronous to the data to be acquired and connected to the phase reference module.
Refer to the online help for more information on using the phase reference function.

1. Select Setup > Phase Ref to display the
Phase Reference dialog box.

2. Turn Phase Correction on by checking
Free Run, Triggered, or Triggered
(SSC).

Free Run: A trigger is automatically
generated. Multi-clock-cycle-period
displayed signals are synchronous
with the phase reference but overlaid.

Triggered: Samples are corrected
for horizontal position per the phase
reference supplied, but otherwise
have all the attributes of a triggered
waveform.

Triggered (SSC): Phase correction
is active and the trigger is used to
determine the horizontal acquisition
window. The instrument assumes
some amount of Spread Spectrum
Clocking contained on the phase
reference input clock.
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3. Click the Source control to select the
module to which you connected the
clock (if more than one phase reference
module is installed).

4. Select the input frequency to the phase
reference module.

Use the Input Freq control to enter the
frequency of Phase Reference clock
or use the Standard Freq Table
button to select a communications
standard.

5. Click the Characterize button to
characterize the clock signal attached to
the phase reference module.

Quick Tips
When entering the phase reference clock frequency, the value must be within 1% of the actual frequency.

The instrument accommodates up to approximately 5000 ppm of SSC.
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Histograms
The instrument can display histograms constructed of waveform data. You can display both vertical (amplitude) and
horizontal (time or distance) histograms, but only one at a time.

1. Display the Hist (Histogram) dialog box.

2. Check the Enable Histogram box.

3. Click the Source button to select the
waveform source.

4. Select a vertical or horizontal histogram.

5. Use the Display Options to change the
appearance of the histogram.

6. Click and drag the edges of the histogram
box to enclose a portion of the waveform.

7. The histogram displays at the edge of
the graticule. The histogram statistics
are displayed in the readout.
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Document Your Results
This instrument can save any number of waveforms, limited only by the space you have to store them. By saving a waveform,
you can recall it at a later time for comparison, evaluation, and documentation. This capability is helpful when you want to:

Recall a waveform for further evaluation or comparison with other waveforms.

Extend the waveform-carrying capacity of the instrument. The instrument supports eight reference, eight channel,
and eight math waveforms. If you want more than eight reference waveforms, you can save the additional reference
waveforms to disk for recall later.

1. To Save a setup or a waveform, click
Save Setup or Save Waveform in the
File menu.

2. To export waveform data, click Export
Waveform in the File menu.

3. To print a hard copy to an attached
printer or a network printer, click the print
icon in the toolbar.

4. To copy a screen image into another
application, choose the Print to file
option in the print dialog box. Save
the screen image in a format that is
compatible with your application, and
then insert the screen image into your
document.
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Skew and Deskewing
The propagation delay inherent in connecting cables and probes can result in inaccurate amplitude and time-correlated
measurements. This is caused by the difference between two or more delays, known as skew. Skew can be present in
multi-channel applications, and is of particular concern in differential systems. To obtain the best measurement and analysis
results from your instrument, you will need to remove skew, a process known as deskewing.

In differential (non-TDR) applications, skew can occur in acquired signals as they propagate from their source to the
mainframe. In TDR applications, skew can occur in signals that propagate from the instrument to the device or system under
test (DUT), specifically the TDR stimulus pulses, as well as from acquired signals.

The following procedures and examples explain how to minimize and measure skew in non-TDR and TDR systems.

Quick Tips
Minimize skew by using balanced cable pairs.

Measure and match your cables. TDR modules such as 80E10, 80E08, and 80E04 allow you to measure cable delays
with very high precision.

In differential systems, use differential probes or differential SMA to single-ended active convertors, such as the Tektronix
P7380SMA.
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Methods to Adjust Skew
Using a Phase Adjuster
Skew can be adjusted with the use of a variable delay line (phase adjuster). Tektronix part number 015-0708-00 is a phase
adjuster with a 25 ps range and VSWR of 1.3:1 at 18 GHz. The advantage of a phase adjuster is that it is functionally
invisible. The disadvantage is that signal fidelity is slightly impacted.

Channel Deskew and Channel Delay
To ensure that random, differential, or common-mode signals can be properly time aligned, the DSA8300 allows the skew to
be adjusted between individual modules by way of independent acquisition timebases (not available in phase reference
mode). This is referred to as channel deskew. In addition, some modules (the 80E06, 80E07, 80E08, 80E09, and 80E10)
contain an additional, and highly useful, skew adjustment capability called channel delay.

While both deskew and delay allow you to compensate individual channels for skew differences introduced externally from
the instrument, they are implemented differently. Deskew is applied to the strobe drive of the module that is common to
both channels in the module. When the deskew values differ between the channels, the instrument automatically performs
separate acquisitions for each channel (on different sets of triggers) in order to satisfy the requested deskew difference.
Delay is applied only to an individual channel in the module. Therefore, to retain maximum performance, keep the deskew
values for both channels in a single sampling module the same and use the delay control if possible.

Channel deskew can be used for repetitive signals. Data is captured with the timebase skew adjusted for each channel, one
at a time. This method of skew adjustment relies on the fact that your signals are completely repetitive relative to the trigger
of your sampling oscilloscope. If, for each trigger, there is always the same signal, the oscilloscope can adjust the skew using
channel deskew. The number of triggers needed to fill the trace doubles relative to an undeskewed acquisition system. More
optimal performance can be obtained using multiple modules or modules with channel delay capability.

Random signals are signals that do not necessarily repeat on equivalent trigger events from acquisition to acquisition.
The oscilloscope must acquire each waveform sample of both differential branches from exactly the same trigger event.
Otherwise, due to the random nature of the signal, one of the samples of the differential pair may have changed value (from
an absolute, real-time perspective) and will yield incorrect results of the mathematical differential or common mode waveform.

Setup Considerations and Procedures
Before starting, there are two setup choices to be made. These are explained in the following sections.

Reference Plane
This is the location at which you ultimately want both the acquisition signals and TDR steps (if you are using TDR) to be time
aligned. (See Figure 1 on page 63.) Common choices for the reference plane include:
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The instrument front panel

The inputs to a DUT (Device Under Test) attached to cables

The inputs to a DUT within a fixture

For best results, select the reference plane at the DUT interface. If it is not possible to inject the signal source at the
desired reference plane, ensure that the signal paths for each of the differential signals are precisely matched between
the DUT and the selected reference plane.

If you are using the 80A05 Clock Recovery Module and routing your differential signals through this module to an acquisition
module, you must leave the 80A05 connected during the deskew procedure. This ensures that any skew introduced by the
80A05 or the connecting cables are accounted for by the deskew procedure.

Figure 1: Schematic diagram of reference planes in relation to signal

Acquisition Deskew Signal Sources
There are three possible signals that may be used as a source to be connected to, or “injected” into, the reference plane.

A TDR step from an extra (unused) TDR-capable module channel (recommended source)

A stable, fast-edge, low-repetition rate signal that is synchronous to an external trigger source

The TDR CLOCK OUT signal from the instrument front panel

The TDR step source is preferred because it provides a fast, stable edge at a low repetition rate that is ideal for deskewing
signal paths. The low repetition rate signal should have a repetition rate much lower than the amount of skew that needs to
be removed so that the relative skew between signals can be correctly determined.
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The following are three procedures to set up your instrument in preparation to perform an Acquisition Deskew. Choose
the procedure related to the signal source you are using.

TDR Step Source

1. Display the TDR setup dialog box by
selecting TDR from the Setup menu.

2. Turn on the step by clicking the Preset
button for the source channel. This will
turn on the step and set other scope
parameters (such as trigger source) in
preparation for making measurements.

NOTE. Use only the rising edge polarity.
Autoset in this mode will not find a
negative-going edge.

3. Turn off the display of the channel by
unchecking the ACQ On box for the
source channel. This channel does not
need to be displayed.

4. Connect a cable or TDR probe to the
source channel to use for injecting the
TDR step signal into the reference plane.

External Signal

1. Set the trigger source to Direct or Clock
[Prescale/Clock] as appropriate for the
bandwidth of the trigger signal.

2. Connect the trigger signal to
the appropriate mainframe input
(TRIGGER DIRECT INPUT or CLOCK
INPUT/PRESCALE TRIGGER).

3. Connect a cable or TDR probe to the
low-repetition source signal that is
synchronous with the trigger signal
to use for injecting the signal into the
reference plane.
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TDR CLOCK OUT

1. Set the trigger source to TDR.

2. Connect a cable or TDR probe from the
TDR CLOCK OUT connector on the front
panel of the mainframe to the reference
plane of the DUT.

NOTE. You may need to use a 50 Ω
terminated SMA T, a 50 Ω terminated power
divider, or a 2 – 6 dB attenuator on the
TDR CLOCK OUT connector to reduce the
amplitude to an acceptable amplitude for the
module.

For fixture or DUT locations that do not support a cable attachment, the acquisition deskew signal can be injected by a
P8018 single-ended TDR probe.
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Acquisition Deskew Procedure
The following procedure outlines a method to deskew a single differential (or common) mode system (one signal pair). The
procedure can be extended to additional signal pairs as needed. This method time aligns the acquisition system such that
the data is acquired simultaneously at the selected reference plane. The procedure accounts for delay mismatches between
the differential signal lines from the reference plane to the acquisition inputs.

The following example procedure uses Ch3 as the + channel and Ch4 as the – channel.

1. Using the previous discussions on
deskew signal types and reference
planes, inject your selected source signal
at the selected reference plane for the +
channel. Turn Ch3 on.

2. Select Utilities > Autoset Properties.
Choose Edge Mode then click the
Autoset button to autoset the signal.
Click Close to close the dialog box.

3. Click on the Acq Mode drop down
control and choose Average to enable
acquisition averaging.

4. Click the Define Math button on the tool
bar or push the Math front panel button
to display the Define Math dialog box.
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5. Create the following math expression
using the buttons in the dialog: Filter(C3).

6. Set the Filter Risetime to a value that is
less than half the risetime of the source
signal.

7. Check the On box to display the math
waveform then close the dialog.

NOTE. At this point, you can dismiss the
Ch3 display by pressing the CH button on
the front panel and then push the 3 button.

8. Select File > Save Waveform. Save
M1 into R1 by clicking the Save button.
Click Close to dismiss the dialog box. R1
will automatically be displayed.

9. Connect your selected signal source to
the – channel.

10. Display the Define Math dialog box and
modify the math expression to use the
– channel: Filter(C4). You can use the
Backspace button to edit the expression.
Click OK to apply the changes and
dismiss the dialog box.
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11. Select Utilities > Autoset Properties.
Choose Edge Mode then click the
Autoset button to autoset the signal.
Click Close to close the dialog box.

12. Click Setup > Measurement to open the
Measurement Setup tab.

13. Click the Select Meas button and
select the Pulse - Timing > Delay
measurement. Set Source 1 to R1 and
Source 2 to M1.

14. Using the previous discussion on
Methods to Adjust Skew, adjust the skew
by changing the Delay or Deskew value
for C4 or by changing the external phase
adjustor until the measurement reads
near zero.
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TDR Step Deskew Procedure
TDR Step Deskew time aligns the TDR steps such that the stimulus steps arrive at the selected reference plane at precisely
the same time. This procedure requires that an Acquisition Deskew be performed first so that the acquisition channels are
properly aligned. It is important that the same reference plane be used for both the Acquisition Deskew and the TDR Step
Deskew procedures to avoid possible misalignment of the signals.

1. Ensure that either an open or a short is
present at the reference plane for the
TDR channels to be deskewed. For best
results, both channels should have the
same termination.

NOTE. Before proceeding, be sure to set
the polarity of the TDR steps to match the
step polarities of your application if they are
different than the defaults used here (for
example, if you are using a common mode
measurement).

2. Select Setup > TDR to open the TDR
Setup dialog box.

3. Click the differential preset button for
the measurement channels. The TDR
preset sets the odd channel to a positive
step and the even channel to a negative
step. In this procedure, we will use Ch3
and Ch4 as the positive and negative
channels.

4. Change the units for both channels to V
(Volts), then dismiss the dialog box.
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5. Select Utilities > Autoset Properties
to display the Autoset Properties dialog
box. Choose TDR Mode and clear the
Display Incident Edge check box.

6. Perform an autoset by clicking the
Autoset button in the dialog box then
dismiss the dialog box.
a. Given reasonably matched paths to
the DUT, both reflected edges should
be displayed near the 3rd horizontal
graticule. If not, increase the Horizontal
Scale until both reflected edges are
displayed on the screen.
b. Adjust Horizontal Scale (and Position,
if necessary), such that the two reflected
edges are visible and apart from each
other in order to obtain good horizontal
resolution. A 10 to 1000 ps/div horizontal
scale is a typical target.

7. Click the Define Math button on the tool
bar or push the Math button on the front
panel to display the Define Math dialog
box.

8. Create the math expression Filter(C3)
for M1.

9. Set the Filter Risetime to a value that is
less than half the risetime of the reflected
TDR step.

10. Check the On box to display the math
waveform.

11. Click Apply.

12. Select M2 from the Math Waveform
area and create a math expression
Filter(C4) for the – channel. Set the
Filter Risetime to a value that is less than
half the risetime of the reflected TDR
step. Select the On box to display the
math waveform. Dismiss the dialog box.
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13. Display the Measurement Setup dialog
box by choosing Measurement from the
Setup menu.

14. Click the Select Meas button and select
Pulse-Timing > Delay.

15. Click the Source 1 button and do the
following:
a. Click the Source tab and set Source
1 to M1.
b. Click the Region tab and set the
Slope to +/-.

DSA8300 Quick Start User Manual 71



Skew and Deskewing

16. Click the Source 2 button and do the
following:
a. Click the Source tab and set Source
1 to M2.
b. Click the Region tab and set the
Slope to +/-.

17. Open the Setups dialog box and click
the TDR tab. Use the Step Deskew
area to select which channel you want
to adjust for deskew. Adjust the Step
Deskew value until the measurement
reads near zero.

NOTE. For future use with the same
configuration (such as instrument, modules,
cables, and/or fixtures), save the setup by
selecting File > Save Setup As from the
menu bar.
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Cleaning the Instrument
Periodically you may need to clean the exterior of your instrument. To do so, follow the instructions in this section.

WARNING. Before performing any procedure that follows, power down the instrument and disconnect it from line voltage.

Exterior Cleaning

CAUTION. To prevent getting moisture inside the instrument during external cleaning, use only enough liquid to dampen the
cloth or applicator.

Clean the exterior surfaces of the chassis with a dry lint-free cloth or a soft-bristle brush. If any dirt remains, use a cloth or
swab dipped in a 75% isopropyl alcohol solution. Use a swab to clean narrow spaces around controls and connectors. Do
not use abrasive compounds on any part of the chassis, as they may damage it.

CAUTION. Avoid the use of chemical cleaning agents, which might damage the plastics used in this instrument. Use a 75%
isopropyl alcohol solution as a cleaner and wipe with a clean cloth dampened with deionized water. (Use only deionized
water when cleaning the menu buttons or front-panel buttons.) Before using any other type of cleaner, consult your Tektronix
Service Center or representative.

Flat Panel Display Cleaning
The instrument display is a soft plastic display and must be treated with care during cleaning.

CAUTION. Improper cleaning agents or methods can damage the flat panel display. Avoid using abrasive cleaners or
commercial glass cleaners to clean the display surface. Avoid spraying liquids directly on the display surface or scrubbing it
with excessive force.

Clean the flat panel display surface by gently rubbing the display with a clean-room wipe (such as Wypall Medium Duty
Wipes, #05701, available from Kimberly-Clark Corporation).

If the display is very dirty, moisten the wipe with distilled water or a 75% isopropyl alcohol solution and gently wipe the display
surface. Avoid using excess force or you may damage the plastic display surface.

Optical Connector Cleaning
Keep the optical module connectors clean to maintain measurement accuracy. The optical module user manual contains the
procedures for cleaning optical connectors.
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Restoring the Operating System
You can restore the Microsoft Windows 7 operating system (OS) in the event that the operating system will not start when
powering on the instrument.

CAUTION. The restore process reformats the hard drive and reinstalls the operating system. All data on the disk is lost. If
possible, save important files to external media before you perform an operating system restore.

You will need to reinstall the TekScope application if you restore the OS from the DVD recovery media. You will not need to
reinstall the TekScope application if you restore from the instrument hard drive.

Restoring the Operating System from the Instrument Hard Disk Drive
These instruments contain an operating system restore file on a separate partition of the hard disk drive.

NOTE. This restore method reinstalls the operating system and the TekScope application software and drivers.

1. Restart the instrument. During the boot-up process you will see the following message in the center of the screen:

Starting Acronis Loader...
press F5 for Acronis Startup Recovery Manager

2. Repeatedly press the keyboard F5 key until the Acronis True Image Tool opens. There is a three-second time period
from when the message appears until the instrument proceeds with the normal instrument startup. If the instrument does
not open the Acronis application, power off the instrument, then power on the instrument and try again.

3. Click Restore.

4. In the Confirmation dialog box, click Yes to restore the instrument operating system, or No to exit the restore process.
The restore process takes approximately 30 minutes; the actual time depends on the instrument configuration.
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Restoring the Operating System with Restore Media

NOTE. This procedure requires that the DVD drive is set as the first boot device (this is the default setting).

NOTE. You can only use restore discs on the instrument for which they were created.

1. Insert the OS recovery media DVD disc 1 in the instrument DVD drive.

2. Restart the instrument. The restore software opens automatically if the DVD drive is the first bootable device. If the
DVD drive is not the first bootable device you will need to enable it as the first bootable device before performing a
restore from the DVD disc.

3. Click Restore.

4. In the Confirmation dialog box, click Yes to restore the operating system, or No to exit the restore process. Follow on
screen instructions. You will need to swap DVD 1 and DVD 2 as instructed.

5. When the restore process is completed, remove the disc and restart the instrument. The instrument will open into the
operating system, settings, and appearance as shipped from the factory.

6. Proceed to restoring the TekScope product software and any additional applications. Follow the installation instructions
that shipped with the DSA8300 Application Install CD.
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